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Creación de componentes en LTSpice

ETSII. Dpto. de Tecnología Electrónica. Pedro Díaz Hernández

LTSPICE
Linear Technology Simulation Program with Integrated
Circuits Emphasis (Programa de simulación con 
énfasis en circuitos integrados).
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Creación de componentes

Existen varias formas de utilizar/incluir componentes nuevos en LTSpice
1. Incluir un Subcircuito/Modelo a una librería nueva, con símbolo propio (más 

laborioso).2. Incluir los datos del Modelo/Librería en el esquema (.LIBRARY, .INCLUDE).3. Añadir los datos del Modelo al esquema (.MODEL).4. Incluir los datos del Modelo a las librerías de serie del programa (standard.*, 

pudiendo ser “dio, mos, bjt, ind, res, cap…”).5. Que el programa cree un símbolo a partir de un Subcircuito existente (No válido para 

Modelos).6. Crear componentes a partir de los existentes (Puente de diodos).
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Creación de componentes: Añadir un modelo existente, con símbolo propio (LM324)

1) Cree un subdirectorio en el directorio de Subcircuitos de LTSpice. Normalmente C:\Archivos de programa\LTC\LTspiceIV\lib\sub. En 
mi caso, al subdirectorio le llamaré PDH. Los subcircuitos son las conexiones internas del C.I., con componentes elementales, que 
conforman su funcionamiento. Con lo cual quedará:C:\Archivos de programa\LTC\LTspiceIV\lib\sub\PDH
2) Cree otra carpeta en el directorio de Símbolos de LTSpice C:\Archivos de programa\LTC\LTspiceIV\lib\sym. En mi caso, igual que 
antes le llamaré PDH (El nombre puede ser diferente al anterior). Los símbolos son las formas normalizadas de los componentes en el 
Capturador de esquemas. Con lo cual quedará:C:\Archivos de programa\LTC\LTspiceIV\lib\sym\PDH
3) Encuentre el modelo Spice del circuito integrado que desee, en nuestro caso LM324, (Normalmente suele tener extensión .MOD, 
pero puede ser cualquier otra “.LIB, .TXT”). Los fabricantes suelen suministrar gratuitamente la mayoría de los modelos de sus 
integrados. En nuestro caso se encontró en Texas Instruments: (ver más adelante…)http://www.ti.com
4) Descargue este pequeño archivo y guárdele en el subdirectorio de Subcircuitos de LTSpice (creado en el punto 1: 
LTspiceIV\lib\sub\PDH). Modifique la extensión del mismo a “ .lib” para que sea asumido por LTSpice como un componente de librería.C:\Archivos de programa\LTC\LTspiceIV\lib\sub\PDH\LM324.lib
5) Abra este fichero (Con el Bloc de Notas o similar). En algún párrafo del mismo estará la definición del subcircuito definido como:.SUBCKT LM324    1 2 3 4 5
Si contuviese alguna definición o letra adicional, elimínela. El componente debe llamarse exactamente igual que lo que aparezca en el 
comando de punto de SPICE “.SUBCKT”. El resto de números de la línea son los pines del C.I. Guarde el fichero.

6) Necesita un símbolo para este subcircuito. Puede crearlo desde cero o utilizar uno existente. Elegiremos la segunda opción. El 
símbolo genérico para el operacional (con pines de alimentación) es el opamp2 existente en el subdirectorio de símbolos de LTSpice:C:\Archivos de programa\LTC\LTspiceIV\lib\sym\Opamps\opamp2.asy
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Creación de componentes: Añadir un modelo existente, con símbolo propio (LM324) 2 de 10

Cópielo al subdirectorio de símbolos creado en el punto 2. Renómbrelo con el nombre del Subcircuito creado en el punto 5, con 
extensión “ .asy”.

C:\Archivos de programa\LTC\LTspiceIV\lib\sym\PDH\LM324.asy

7) Debemos asignarle este símbolo esquemático al subcircuito descargado. Para ello, arranque LTSpice y en File->open. Cambie el tipo 
de archivo a cargar a: “Symbols (*.asy)”  y sitúese en el subdirectorio de símbolos creado en el punto 5 y abra el fichero LM324.asy.

8) En el menú principal de LTSpice elija : Edit->Attributes->Edit Attributes (o presione Ctrl+A). En la tercera línea cambie el valor del 
atributo Value de opamp2 a LM324. En la octava línea (Atributo ModelFile ), escriba el nombre donde se encuentra el subcircuito
guardado con anterioridad (PDH\LM324.lib). No incluya la contrabarra “\” antes del nombre del subdirectorio. Puede modificar el 
atributo Description de la línea 7 por algún texto explicativo del modelo descargado “Amplificador operacional” o algo similar o lo que 
desee. También puede dejarlo como está. Cierre la ventana Edit Attributes (pulsando OK) y guarde el fichero creado File->Save. Cierre 
el programa LTSpice para que los cambios tenga efecto.

9) Arranque el programa LTSpice de nuevo. Seleccione un archivo nuevo File->New Schematic y añada el componente creado Edit-
>Component (F2). Para ello, localice el subdirectorio de símbolos

C:\Archivos de programa\LTC\LTspiceIV\lib\sym\PDH

Y seleccione el componente creado (LM324). Cree un esquema y compruebe su correcto funcionamiento.
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Creación de componentes: Añadir un modelo existente, con símbolo propio (LM324) 4 de 10

Esquemático realizado con el componente añadido a una librería propia con símbolo propio



Con este método hemos incluido en nuestra librería un modelo para utilizarle en ocasiones posteriores. Pero si se nos olvida 
copiar esta librería (que no está en el subdirectorio de trabajo del esquema, sino en el de instalación de LTSpice), al trasladar 
este esquemático a otro ordenador o cedérselo a otro compañero, el circuito no funcionará, ya que, la librería no estará 
disponible. También es posible que no deseemos que “otras personas” dispongan de TODOS nuestros componentes. Para ello, 
podemos incluir solamente el componente que nos interese al subdirectorio de trabajo del esquema. (ver más adelante…)

El comando de punto para realizar esta tarea es “ .LIB”. (Ej.: .lib mi_libreria.lib)

LTSpice admite que se indique el camino completo donde se encuentra la librería. Si esto no es así, el programa busca en:

1. <LTspiceIV>\lib\cmp. (Siendo <LTspiceIV> = C:\Archivos de programa\LTC\LTspiceIV)
2. <LTspiceIV>\lib\sub.
3. Subdirectorio donde se ha guardado el esquema.

El nombre del fichero debe estar completo, extensión incluida.

Adicionalmente, también se puede incluir una dirección Web como “.lib http://www.company.com/models/library.mod”. 
LTSpice crea una copia de la librería, una vez simulado el esquema, en el subdirectorio de trabajo. (ver más adelante…)
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Creación de componentes: Añadir un modelo existente, con símbolo propio (LM324) 5 de 10

Incluir librerías
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Creación de componentes: Añadir un modelo existente, con símbolo propio (LM324) 6 de 10

Incluir librerías  II

Realizamos el esquema con el operacional genérico 
(opamp2) de la librería original “opamps” de LTSpice. 
Pulsamos CTRL+right click sobre el integrado, modificamos 
el atributo “Value” por el nombre del subcircuito de la 
librería que hemos añadido (LM324) e indicamos en el 
esquema que deberá “leer” la definición del subcircuito del 
subdirectorio de trabajo. Con la directiva Spice añadimos 
“.lib lm324.lib”.
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Creación de componentes: Añadir un modelo existente, con símbolo propio (LM324) 7 de 10

Incluir librerías y III

Realizamos el esquema con el operacional 
genérico (opamp2) de la librería original 
“opamps” de LTSpice. Pulsamos 
CTRL+right click sobre el integrado, 
modificamos el atributo “Value” por el 
nombre del subcircuito del fichero que 
hemos añadido (LM324.txt) e indicamos 
en el esquema que deberá “leer” la 
definición del subcircuito del 
subdirectorio de trabajo. Con la directiva 
Spice, añadimos “.include lm324.txt”.
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Creación de componentes: Añadir un modelo existente 8 de 10

Incluir modelos

Imaginemos que deseamos que nuestros esquemas sean 
autocontenidos. Es decir, que no necesiten ficheros adicionales 
para realizar la simulación en cualquier ordenador, salvo los 
que vienen de serie con el programa. Simplemente con el fichero 
“ .asc” será suficiente: Insertando la definición completa del 
modelo deseado en el esquema.

Realizamos el esquema con los componentes de serie, diodo genérico (D). Pulsamos CTRL+right click y en el atributo Value, indicamos el nombre del comando “.MODEL” que hemos incluido con la directiva Spice.
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Creación de componentes: Añadir un modelo existente 9 de 10

Incluir modelos y II

Si estamos trabajando con modelos de fabricante, también 
podemos descargar de la Web la definición del modelo a utilizar. 
El procedimiento es idéntico al mostrado en casos anteriores. La 
directiva “.inc” o “.include” debe indicar con total exactitud el 
fichero a descargar. Es sensible a las mayúsculas.Realizamos el esquema con los componentes de serie, diodo genérico (D). Pulsamos 
CTRL+right click y en el atributo Value, indicamos el nombre exacto que exista en el “.MODEL”. A pesar que en el “.INC” no haga referencia exactamente al mismo. No 
confundir la llamada a un fichero con el 
contenido del mismo.
Una vez simulado el esquema, LTSpice deja una 
copia de la librería en el subdirectorio de trabajo.
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Creación de componentes: Añadir un modelo existente 10 de 10

Añadir modelos a los existentes      1N4001LTSpice no dispone de todos los Modelos de componentes existentes en el mercado. Se ha visto la manera de introducir estos nuevos componentes en los esquemáticos, pero si deseamos que formen parte de los componentes que trae la aplicación y que no se nos olvide añadirles o la forma de hacerlo…
• Se modifica el fichero de texto de los diodos que trae el programa 

C:\Archivos de programa\LTC\LTspiceIV\cmp\standard.dio. Añadimos el Modelo nuevo. Cerramos y abrimos de nuevo el programa para que los cambios tengan efecto.
• Se realiza un esquemático con el diodo genérico u otro cualquiera y pulsando botón derecho encima del diodo, en Pick New Diode, se selecciona el diodo recién añadido.

Al incluirse en la librería 
de diodos del programa, 
standard.dio, toma el 
símbolo de éstos.
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Creación de componentes: Añadir un Modelo/Subcircuito existente

R E S U M I E N D OComo se ha mostrado, se pueden incluir Modelos/Librerías/Subcircuitos de componentes de muy diversas formas:1. Haciendo todo nuevo (Copiando el modelo y realizando/copiando el símbolo) y transformándolo en una librería propia.2. Incluyendo la llamada al modelo en el propio esquema “.LIB”, a través de una dirección Web, o guardándole en un directorio conocido o el del propio esquema (con extensión .MOD, .LIB o .TXT).3. Incluyendo la llamada al modelo en el propio esquema “.INC” o “.INCLUDE”, a través de una dirección Web, o guardándole en un directorio conocido o el del propio esquema (con extensión 
.MOD, .LIB o .TXT).4. Copiando en el mismo esquema la definición del modelo “.MODEL”.5. Añadiéndole a la librería de los componentes originales que vienen con el programa. El mayor 
inconveniente de este procedimiento es que si actualizamos el programa o simulamos en otro 
ordenador, los datos se perderán o no estarán disponibles.

Recuerde que: si no creamos el símbolo o utilizamos un componente básico (primitiva de LTSpice), deberemos modificar el 
componente básico e indicar el modelo que deseamos incorporar.
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Creación automática de símbolos a partir de los Subcircuitos

Si disponemos del Subcircuito “.SUBCKT” que define el funcionamiento de un componente podemos generar elsímbolo de forma automática, para ello…

Abrimos con LTSpice el subcircuito que nos interese (LM324.MOD),colocamos el cursor encima de la línea donde se encuentre el “.SUBCKT” ypulsamos botón derecho. Aparecerá un menú desplegable con la opción“Create Symbol”. Al pulsar sobre ésta nos preguntará si deseamos crear elsímbolo de ése subcircuito con sus pines (ports) de conexión. Al responderafirmativamente, nos abrirá otra ventana en LTSpice con el símbolo creadosegún los pines que tenía definido el “.SUBCKT”.
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Creación automática de símbolos a partir de los Subcircuitos y II

El símbolo se habrá creado automáticamente en C:\Program Files\LTC\LTspiceIV\lib\sym\AutoGenerated. Estesubdirectorio especial, que no existía con anterioridad, contendrá todos los símbolos creados mediante este método.El fichero creado “LM324.asy” contiene la información de la propia figura y delfichero “.SUBCKT” del cual parte. Con lo cual, si modificamos la situación delmismo (LM324.MOD), no funcionará el esquema. Por ello, se recomienda guardartodos los Subcircuitos, Modelos, Includes, etc. en el mismo lugar.Este método sólo es válido para los ficheros que contengan en sudefinición/declaración el comando de punto “SUBCKT”. No válido para “.MODEL”.
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Creación de componentes a partir de los existentes

Otra forma de añadir componentes nuevos al programa es realizando subcircuitos basados en componentesexistentes. Por ejemplo, un puente de diodos como rectificador de onda completa para las fuentes de alimentación(ocupará menos que los cuatro diodos típicos y es mucho más rápido y claro el esquema).Para ello, se realiza el esquema de conexionado de los componentes que conformarán el circuito, nombrando lospines de Entrada/Salida de forma inequívoca.En este ejemplo se muestra la conexión típica de un puente de diodos.
• Los terminales AC1 y AC2 serán los terminales de c.a. (normalmente unidos

al trafo en las FF.AA.)
• Los terminales V+ y V- son las salidas positiva y negativa (normalmente

unidos al positivo y masa respectivamente).Estas conexiones son del tipo “Label Net” del programa. Sirven para nombraruna conexión de Entrada/Salida/Bidireccional o None. Pudiendo hacerreferencia a ella durante la visualización de las gráficas de una forma máscómoda que con el nombre de las Nets (N0003…).Para este caso, en vez de utilizar un diodo genérico u otro existente en elprograma (1N4148, 1N914…), utilizaremos uno nuevo, con datossuministrados por On Semiconductor (proceso explicado en la página 11 yposteriores). Se muestra y se copia parte de la Netlist del esquema
View>SPICE Netlist.
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Creación de componentes a partir de los existentes II

Copiaremos las conexiones entre los diodos, es decir, las líneas que hacen referencia a las conexiones de D1 a D4. Elresto de líneas es para situación de librerías y finalización del fichero de Netlist. Podemos cerrar la ventana deNetlist.Éstas líneas y las que se muestran a continuación son las que conforman el Subcircuito que deseamos, llamadoPUENTE. Se pueden realizar en un fichero nuevo, de texto, o en el fichero de librerías con el que estemos trabajando.
.SUBCKT PUENTE AC1 AC2 V+ V-
D1 V- AC1 1N4007
D2 V- AC2 1N4007
D3 AC1 V+ 1N4007
D4 AC2 V+ 1N4007
.MODEL 1N4007 D(Is=7.02767e-09 Rs=0.0341512 N=1.80803 Eg=1.05743
+ Xti=5 Iave=1 Vpk=1000 bv=1000 Ibv=5e-08 Cjo=1e-11 Vj=0.7 M=0.5
+ FC=0.5 TT=1e-07 KF=0 AF=1)
.ENDS PUENTE

• En la primera línea, con el comando de punto “.SUBCKT” se indica al programa que definiremos un subcircuitoseguido del nombre deseado (PUENTE) y cómo se nombrarán los pines del mismo que realicen funciones deEntrada/Salida (AC1, AC2, V+ y V-), no para el resto de interconexiones entre componentes.
• En las sucesivas cuatro líneas están los datos copiados de la Netlist (Que no es otra cosa que la definición de las

conexiones entre los cuatro diodos), todos del mismo tipo (1N4007).
• Con el comando “.MODEL” indicamos que se va a proceder a la definición de un modelo de componente (los datoscitados con anterioridad de On Semiconductor). Las líneas que comienzan con un “+” es para indicar quecontinúan los datos como si fuese una única línea (se hace por comodidad visual). Con esta forma estamosindicando explícitamente los datos del modelo de los diodos en la propia definición del Subcircuito. Si el modelode diodo utilizado estuviese definido de serie en el programa, el comando .MODEL no sería necesario ya que elprograma contendría los datos del diodo utilizado.
• Se finaliza la definición del Subcircuito con el comando “.ENDS” y el nombre del propio Subcircuito.
• Se guardan los datos en el fichero creado o ya existente, siempre en modo texto (ASCII).
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Creación de componentes a partir de los existentes III

Ahora nos queda realizar el dibujo esquemático que representará al componente así creado File>New symbol.
• Añadimos los cuatro pines del componente. Se nombrarán por el ordenindicado en el comando “.SUBCKT” y con el mismo nombre (AC1 → 1, AC2 → 2,V+ → 3 y V- → 4).
• Se rellenan los datos de la ventana Symbol Attribute Editor(Edit>Attributes>Edit Attributes o bien Ctrl+A).
• La última línea “ModelFile” indica el subdirectorio donde se ha guardado elfichero del Subcircuito y el nombre del mismo. (No colocar la primera “\ oAntislash” del subdirectorio).
• Ahora guardaremos el símbolo creado en otro fichero, pero con extensión“.ASY” normalmente en C:\Program Files\LTC\LTspiceIV\lib\sym\XXX\XX.ASY.

De esta forma hemos creado un símbolopropio que tiene asociado el comportamientode un rectificador de onda completa en base adiodos 1N4007 conectados en la forma quehemos decidido.Esto mismo puede realizarse para todo tipo decomponentes o asociaciones de los mismos.



20

Creación de componentes a partir de los existentes y IV

Para comprobar su correcto funcionamiento, nada mejor que un circuito nuevo…
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Datos generales

LTspice leading characters

• A  special functions device
• B  arbitrary behavioral source
• C  capacitor
• D  diode
• E  voltage dependent voltage source
• F  current dependent current source
• G  voltage dependent current source
• H  current dependent voltage source
• I  independent current source
• J  JFET transistor
• K  mutual inductance

• L  inductor
• M  MOSFET transistor
• O  lossy transmission line
• Q  bipolar transistor
• R  resistor
• S  voltage controlled switch
• T  lossless transmission line
• U  uniform RC-line
• V  independent voltage source
• W current controlled switch
• X  subcircuit invocation
• Z  MESFET transistor
• *  comment
• +  continuation of prior line
• .  simulation directiveInformación relacionada

http://www.intusoft.com/models.htm#freemodels
http://www.penzar.com/links.htm
http://www.simonbramble.co.uk/lt_spice/ltspice_lt_spice.htm
http://ee.cleversoul.com/simulation.html
http://cmosedu.com/
http://www.onsemi.com/site/support/models
http://www.coilcraft.com/modelsswcad.cfm
http://tech.groups.yahoo.com/group/LTspice/
http://ltspice.linear.com/software/scad3.pdf
http://www.ece101.com/2010/01/an-introduction-to-LTspice/
http://denethor.wlu.ca/LTspice/
http://claymore.engineer.gvsu.edu/~steriana/Videos/
http://ece.sdsmt.edu/ee221/Intro%20to%20LTspice.pdf
http://home.zcu.cz/~panek50/TE1/Introduction%20to%20SwitcherCAD.pdf
http://www.linear.com/designtools/software/LTspiceGettingStartedGuide.pdf

T = tera = 1012G = giga = 109MEG = meg = 106K = kilo = 103M = milli = 10-3U = micro = 10-6N = nano = 10-9P = pico = 10-12F = femto = 10-15
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Fin
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